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BASIC OPERATING INSTRUCTIONS 

FOR THE SIERRA II 

 

Setup and Start up 
 

Always check the PCMCIA Ethernet Card to make sure it is well seated and the cable 

connection is made with the base unit.  Always turn the base unit on first, then the 

Laptop.  From the Windows ‘desktop’ screen double-click the SierraXP icon.  The 

program will take about 15 seconds to load and will take you directly to the Add Patient 

Information screen (if this screen does not appear, press the New Patient (F1) function 

key).  You will need to put in a last name and a first name before proceeding.  The ID# is 

generated automatically using a combination of the lastname, firstname and date.  If 

desired, you can change the ID# before exiting this screen.  This is how the Sierra 

software keeps track of and saves patient information.  To continue on and select a test 

press the Enter key on laptop keyboard or click the Start Test button.   The system will 

now display a menu of tests. 

 

Selecting a Test 
 

You can select a test from the Test Protocol menu, using Knob 1, (highlight the test by 

turning the knob then press the knob to select), or by using the Test Keys 1, 2, and 3 on 

the base unit.  On the base unit, under the bold word TEST, typically (1) will load EMG, 

(2) will load NCV/F/H, (3) will load SEP, and (ALL) will display the full Test Protocols 

menu.  You can go back and forth between tests at will without losing any data. The test 

select buttons can be reprogrammed to select any test from your test protocols list.   You 

can also use the mouse for any of these functions. 

 

Controls on the Base Unit 
 

In any given test protocol you will see four small boxes on the lower left side of the 

screen.  These refer to the F1-F4 keys on the base unit.  You will also see four small 

circles on the lower right side of the screen, these refer to the four Knobs on the base 

unit.  Turn the knobs to select/highlight a parameter and press to modify.  The words 

written to the (left of) the knobs define what the knobs do.  An example of this is if you 

are in ‘NCV/F/H’ or ‘EMG’, Knob 4 is defined as Gain and Sweep on the screen.  To 

change the Gain – simply turn Knob 4.  The adjusted Gain will display in the Gain box 

on the upper left corner of the screen.   To change the Sweep – simply press Knob 4 (the 

word Sweep is now highlighted) now turn the knob to adjust the sweep speed.  Each of 

the knobs uses similar logic. 
 

 
EMG Function keys. 

 

 
EMG Knobs. 
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Nerve Conduction Studies 
 

When you select the NCV/F/H protocol you will get a list of nerves.  You can select the 

specific nerve and call it up on the screen by using Knob 1 or the mouse.  You can select 

the appropriate “Side” prior to selecting the nerve by using the F1-Ch. Side key. 

 

 
Nerve List. 

 

Adjust the stimulus intensity by turning the black roller on the hand held stimulator or by 

using the Intensity knob (knob #3)on the base unit.  To stimulate, pull back the black 

roller on the stimulator or press the Single key on the base unit. 

 

On the NCV/F/H screen the top grid (box) is for active traces.  Once you get the desired 

response, press the store key on the bottom right side of the base unit.  You can also 

press the footswitch to perform the store function.  In order for the numbers (values) to 

be stored, you must store the traces.  Storing moves the active trace down into the 

stored grid (box).  You are now ready to stimulate the next site.   
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NCV test protocol screen. 

 

You can re-stimulate and/or replace any trace by using F2-Next Site.  Press Next Site 

until the black triangular pointer is next to the site name in the site table (upper right side 

of screen) that you want to re-stim.  Now, stimulate the nerve and acquire an active trace.  

If you store this trace, it will replace the trace for the selected site in the stored grid.  If 

you decide not to replace the original stored trace, simply press the Clear key. 

 

Adjusting Cursors Manually 

 

You can adjust the ‘onset’ and ‘peak’ latency cursors (that the auto cursors did 

not pick accurately) while the trace is still in the active grid – simply use Knob 2-

Onset/Peak and turn to adjust.  If the trace has been stored and is in the lower 

grid – press the button labeled ‘Cursor’ on the base unit.  By using Knob 1-

Cursor Sel/Move you can select and move all the cursors on the trace.  Just turn 

and press.  You can also use the mouse in the stored grid to easily move cursors 

around.  Point and left-click the mouse on the cursor +, by holding down on the 

mouse you may drag the cursor to whatever point you want and then release the 

mouse. 

 

Note:  If you use the Cursor key method, press the OK key when you are finished 

moving the cursors.  This will reset the knob and function key labels to their 

normal acquisition labels. 
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How to Use ‘Distance’ for Velocities 

 

Press F1-Distance and enter the distance (in centimeters) from the laptop 

keyboard - followed by Enter.  The velocity will appear in the velocity box of the 

segment table (lower right).  If you want to change the distance – simply press 

F1-Distance again until you return to the appropriate line.  Always make sure you 

are measuring the right segment by reviewing the segment sites in the lower right 

corner of screen.  For example, Wrist to Elbow and the appropriate distance 

should be applied. 

 

Other Options in Nerve Conduction  

 

Using Knob 1 (or the mouse) you can change the Gain, Hi-cut filter, Lo-cut 

filter, Sweep, etc. for the Live Grid. 

 

 
Parameters toolbar. 

 

Further to the right you can Sort Traces   (according to ascending latencies), 

Swap Sides   (if you forgot to select the proper side first), adjust Pulse 

Duration, or turn ‘Averager’ on/off   .  By highlighting the icon with the 

mouse, a small box will appear and tell you the function of the toolbar button.  

While the mouse is positioned over an icon you can also look at the Status Bar 

(area of screen just below the Function key prompts) for a description of what the 

highlighted button will do. 

 

 
Status Bar. 

 

 

To go on to the next nerve, press F3-Next Nerve and you are back at the nerve list. 

 

To change test protocols, press one of the test keys 1, 2, or 3 or the All key.  You can also 

use the mouse to click on the Test Protocols menu at the top of the screen. 
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How to Change the Nerve List Order, Default Parameters, and Normals 
 

Start the Sierra program.  Select System Setup from the Edit menu.  Click on the Test 

Setup tab, then, click on NCV/F/H to highlight this test.  Now, click on the Test Setup 

button.  Three tabs are available.  When you close this window all your changes are 

automatically saved. 

 

 
NCV/F/H Test Setup screen. 

 

 

Changing the Nerve List Order:   

Select Nerve List (see next page).  Position the mouse at the leftmost box on the 

row (nerve) and left-click to highlight the row, left-click again and while holding 

down the mouse button drag the row to the desired location.  A red line indicates 

where the row will be positioned when the button is released.  The row is position 

above the red line.  

 

Deleting a Nerve from the list: 

Select Nerve List and use the mouse to right-click on the leftmost box on the 

row (nerve) you wish to delete.  A popup menu is displayed with the options 

Insert row or Delete row.  Click Delete row. 

 

Inserting a New Nerve in the list: 

Select Nerve List and use the mouse to right-click on the leftmost box on the row 

(nerve) where you want the new nerve to go (the new nerve will be inserted above 

the row you click on).  A popup menu is displayed with the options Insert row or 

Delete row.  Click Insert row.  Next, fill in the Nerve name, select the type 

(motor, sensory) and fill in the ref site (recording site).  Now proceed to the 

bottom of the window and fill in the Site names and then define the Segments.  

Note: if you do not fill in the type and ref site fields the Sierra will use the name 

you entered as a section header (i.e., Upper Motor). 
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Reprogramming Nerve Sites, Segments and Normals: 

To reprogram nerve sites on a given nerve select the nerve with the mouse.  Then 

retype the site names in the lower left corner of screen.  Segments can also be 

reprogrammed from this screen by using the mouse (left button) and clicking on 

the segment to be changed (a small menu of available sites will pop up and again 

by selecting with the mouse you can select the desired site and build your 

segment).  Distances can be pre-entered simply by typing the distance (cm) in the 

distance field. 

 

 
Setting up the nerve list. 

 

Programming Default Parameters: 

Change default parameters on any of the nerves from the  ‘Nerve\Group 

Settings’ tab.  This can be done for individual nerves or for all of the Motors, 

Sensory, F-Waves, etc by changing the parameters for the default nerves at the 

bottom of the drop-down list. 
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Using the TabData View 
 

At any time during testing, press the F4-TabData function key to view a summary of all 

the tests that have been performed on the patient. 

 

The left side of this view shows a “tree” of the tests performed.  You can turn Knob 1 to 

highlight the individual entries in this tree.  The right half of this view will then update to 

show the data for the highlighted entry in the tree.  For example, if you highlight the Left 

Median Motor nerve in the tree, the right half of the screen will show the traces and 

tabulated measurements for this nerve.  If you highlight a section heading, like All Motor, 

then you will see a table of all motor nerves. 

 

 
TabData View with All Motor nerve table selected. 

 

 

Opening a Test: 

You cannot adjust any of the cursors in the TabData view.  In order to do this you 

must first re-open the test, simply press Knob 1 or click the Open Test button to 

re-display the acquisition screen.  Now you can make adjustments to the cursors 

either by using the mouse or Cursor key. 

 

Sorting the NCV entries: 

You can sort the NCV/F/H tables in 3 ways.  Click on Nerve/Side to sort the 

tables first by nerve name then by side.  Click on Side/Nerve to sort the tables 

first by side then by nerve name.  Or, select None to sort the tables in the order 

the nerves were acquired. 
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Sorting the EMG Scoring Table: 

Double click the mouse at the top of any column in the muscle score table to sort 

the table based on the contents of that column.  For example, if you double click 

on the Nerve column the table will be alphabetically sorted by nerve name. 

 

Column Setup for Motor & Sensory tables: 

When any part of the NCV/F/H tree (left side) of the TabData View is highlighted 

a  button labeled “Column Setup” will be displayed.  Clicking on this button will 

display a setup screen that will allow you to select the columns for the motor and 

sensory tables.  These settings take effect when viewing the All Motor, the All 

Sensory, and the Motor & Sensory tables.  The selected columns are also those 

that will be used for the tables in printed reports. 

 

 
 

 

Cancel: 

To exit the TabData view without opening a test click on the Cancel button.  You 

can also press the F4 function key on the base to cancel. 
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Recording and Scoring EMG 
 

After selecting EMG from the test protocols menu you will have the active EMG trace 

on the screen.  There are four primary grids or areas of the EMG protocol screen.  First is 

the Live EMG Data grid, to the right of this is a Muscle List, below the muscle list is 

the Stored EMG Data grid, across the very botton of the window is the Scored Muscle 

Table which is initially blank.  The View key on the base unit will toggle through various 

combinations of these initial screen areas. 

 

 
EMG test protocol screen. 

 

Volume can be adjusted using the Volume knob at the lower left side of the base unit.  

Knob 4 can be used to adjust the Gain or Sweep.  The toolbar across the top of the 

display shows the current amplifier settings, side and notch filter status. Make sure to use 

the Side select box at top of screen to select the appropriate side. 

 

You can ‘capture’ traces using F1-Live/Capture and you can go back and forth from 

insertional activity to recruitment by pressing F2-Fibs/Recrt.  You can always look back 

at your ‘Tabular Data’ by pressing F4-TabData.   
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Storing EMG Traces: 

To Store a trace with a muscle label for your report, freeze the EMG by using the 

footswitch or by pressing the Run/Stop button on the base unit.  Use the Review 

knob (Knob 1) to review through the last 16 sweeps of data until the activity of 

interest is displayed.  Now, turn the Muscle Sel/Score knob (Knob 2) until the 

appropriate muscle is highlighted in the Muscle List and then press the Store 

button on the base unit, answer Yes to the confirmation message.  The trace is 

placed into the Stored EMG Data grid and can be included in reports. 

 

Scoring Muscles: 

To Score a muscle, use the Muscle Sel/Score knob (Knob 2) to highlight the 

muscle in the muscle list and then press this same knob to Score.  All scoring 

columns default as normal.  By using the Score Tbl/Modify knob (Knob 3) you 

can make appropriate changes.  Turn Knob 3 (the cursor moves across the score 

table) until you reach the appropriate box.  Press Knob 3, a list of choices is 

displayed, turn again to select one and press to select it.  (The mouse can also be 

used to score muscles and make scoring choices)  Scoring can also be done easily 

using the F3-Score key.  Pressing this key takes you to a view with the Muscle 

List on top and the Scored Muscle Table on the bottom.  Now, by using Knobs 2 

and 3 you may score the muscles as explained before.  To return to the Live EMG 

screen, press the F1-Main View key. 

 

 
Score View in EMG Protocol 

 

 

Scoring Multiple Muscles Simultaneously: 

Using the Muscle Sel/Score knob (knob #2) you can click on the section name 

(i.e., Hand) and all the muscles in that section will be highlighted.  If you press 

the knob a second time all the highlighted muscles will be scored with the normal 
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defaults.  If you click on the wrong section by mistake, just turn Knob 2 and the 

muscles will be un-highlighted. 

 

 

Deleting a Scored Muscle from the Scored Muscle Table: 

Use the Score Tbl/Modify knob (Knob 3) to highlight the row in the scored 

muscle table that you want to delete.  Next, press the DEL or Delete key on the 

computer keyboard. 

 

Changing the SIDE of a scored muscle: 

Use the Score Tbl/Modify knob (Knob 3) to highlight the row in the scored 

muscle table that you want to change.  Next, use the mouse to click on the Swap 

Sides   button on the main toolbar at the top of the screen. 

 

 

Editing the EMG Muscle List and Scoring Choices 
 

Editing the EMG Muscle List 

Start the Sierra program.  Select System Setup from the Edit menu.  Click on the Test 

Setup tab, then, click on EMG to highlight this test.  Now, click on the Test Setup 

button. Two tabs are available, EMG and Muscle List.  When you close this window 

all your changes are automatically saved. 

 

Changing the Muscle List Order 

Select the Muscle List tab.  Position the mouse at the leftmost box on the row 

(muscle) and left-click to highlight the row, left-click again and while holding 

down the mouse button drag the row to the desired location.  A red line indicates 

where the row will be positioned when the button is released.  The row is 

positioned above the red line when the mouse button is released. 

 

Inserting New Muscles into the List 

Select the Muscle List tab and use the mouse to right-click on the leftmost box on 

the row (muscle) where you want the new muscle to go (the new muscle will be 

inserted above the row you click on).  A popup menu is displayed with the options 

Insert row or Delete row.  Click Insert row.  Next, fill in the Muscle name, the 

nerve and the root level.  Note: if you do not fill in the nerve and root fields the 

Sierra will use the name you entered as a section header, i.e., Hand. 

 

Deleting Muscles from the List 

Select the Muscle List tab and use the mouse to right-click on the leftmost box 

on the row (muscle) you wish to delete.  A popup menu is displayed with the 

options Insert row or Delete row.  Click Delete row. 
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EMG Test Setup – Muscle List. 

 

 

Changing the Muscle Scoring Choices 

The bottom of the EMG tab has the muscle scoring definition table.  The first four 

rows, Side, Muscle, Nerve and Root cannot be modified.   The remaining rows can 

be modified or deleted and new rows can be inserted.  It is important to understand 

that each row in this table actually appears as a column in the Muscle Score Table.   

 

 
EMG Test Setup – Scored Muscle Table Definition. 
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Changing Existing Scoring Choices: 

Type the new choices and separate them with a space.  For example, the first 

word to appear in the ‘list values’ is the default word.  In this case it is Nml (for 

normal), after this word leave a space and type in the next choice, i.e. Incr (for 

increase), etc. 

 

Inserting a New Scoring Column: 

Use the mouse to right-click on the leftmost box on the row  where you want the 

new column to go (the new column will be inserted above the row you click on).  

A popup menu is displayed with the options Insert row or Delete row.  Click 

Insert row.  Next, fill in the Column name, i.e., Fibs.  Now, click in the Options 

field, choose between Read Only, Text, List and ListEdit.  ReadOnly is for non-

editable data like the muscle name.  Text is for comment fields and allows free 

text entry.  List and ListEdit are used for fields that contain preset choices.  List 

only allows you to pick from the pre-defined choices.  ListEdit allows you to select 

from the pre-defined choices or type something else.  It you choose List or 

ListEdit then you must fill in your choices in the List Values field.  Be sure to 

separate your choices with spaces. 

 

Deleting a Scoring Column: 

 Use the mouse to right-click on the leftmost box on the row you wish to delete.  

A popup menu is displayed with the options Insert row or Delete row.  Click 

Delete row. 

 

 

Printing Your Results 
 

Use the Report 1 and Report 2 buttons on the base unit to generate reports.  Typically 

the Report 2 button will take you right into a ‘Quick Print’ routine.  This can be modified 

to fit your specific needs at the time of inservice.  The Report 1 button will typically take 

you to a list of other types of reports and you can choose which one you would like to 

generate.  All of these may also be modified.  Answer the appropriate questions as the 

report is generated.  You will eventually arrive at a preview screen of the report.  This is 

similar to a word processing screen.  From this screen you can make any changes to your 

report by using the mouse, i.e. bold, italic, change font, size, insert page break, etc.  After 

the report is finalized, select the ‘Printer’ icon at the top of the screen to print. 

 

After the report is printed, close the report generator program by clicking on the “X” in 

the upper right hand corner or, select File-Exit.  The program will ask you if you want to 

save the report, click on the button labeled “Save Report in Database”.  The report will be 

saved and can be recalled and re-printed at any time. 

 

For more detailed information on the Report Generator and Template Editor see the 

document titled “Report Generation and Template Editor Description”. 
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Next Patient 
 

Note:  If you are currently viewing the TabData screen for a previous patient, click on 

Cancel or press the F4 button on the base unit to close this view before starting a new 

patient. 

 

To start your next patient, use the mouse to go to the File Menu at the top left corner of 

the screen, and select New Patient.  (ALT & F keys, then Enter key on computer 

keyboard will also accomplish this)  This will take you to the Add Patient information 

page and you can begin a new patient.  NOTE: THE SYSTEM AUTOMATICALLY 

SAVES YOUR PREVIOUS TABDATA WHENEVER YOU CLOSE DOWN THE 

PROGRAM OR SELECT A NEW PATIENT. 

 

 

Reviewing Previously Acquired Patient Data and Stored Reports 
 

Reviewing Patient Data: 

To recall a patient record you must either select Review from the File Menu or 

you can press the F3-Review key if you are in the initial startup screen.  After 

selecting Review a menu will pop up displaying a list of patient files.   By using 

Knob 1 or the mouse you may select the patient to be recalled.  Press the knob or 

click the left mouse button twice to select the appropriate patient. The patient’s 

Tabular Data and Traces are re-displayed.  If a particular patient name is not 

visible in the Review menu, use the search tools on the left side of the review 

screen or scroll down through the list of records using the scroll bar controls. 

 

Reviewing Stored Reports: 

From the Review screen change the file type of  “Sierra”, on the left side of the 

Review screen, to “Report”.  A list of stored reports will be displayed.  Use 

Knob 1 or the mouse to select the report of interest.  The stored report will be 

displayed.   **If the report is not visible within a few seconds place the mouse 

anywhere on the screen and click once and the report should appear.  You may 

now edit or re-print the report. 

 

 

The Custom Report Header File 
 

The report header is an RTF (rich text format) file that is created in the Sierra’s System 

Setup menu.  The Sierra saves this information in a file called “cadheader.rtf”.  Each user 

of the Sierra can have their own unique report header. 

 

Creating the Report Header: 

Start the Sierra program, and if necessary, select the appropriate login name. 

 

1) From the Edit menu, select System Setup.  The System Setup menu is 

displayed. 
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2) Click on the Report Header button. 

 

3) Depending on the software installed on your computer, the report header file 

will be opened with either the WordPad or Word97 program. 

 

 
WordPad program showing report header information 

 

4) Change the information in the report header as needed.  You can use bold text 

and different character sizes.  All the lines should be “left justified” in this 

file. 

 

5) To close the file, click on the “X” in the top right of the window.  Select 

“Yes” to save your changes. 

 

6) The System Setup menu is re-displayed on the screen.  Click “OK” to exit this 

menu. 


